Step-Through Example: Flat Plate with a Single Load

In this example we create a 4 in. square plate with filleted edges (0.5 in. fillet radius) and a

2 in. diameter circular hole in the center. The plate is made of steel, 0.1 in. thick. The
model is simply supported at the corners, and a 10g gravity load is applied normal to the
plate. The plate is modeled with flat plate elements. Grid point displacements and
element stresses are computed.
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This example uses English units: inches (abbreviated in.) for length, pounds (abbreviated
Ib) for force, and seconds (abbreviated sec) for time. Note that MSC/NASTRAN for
Windows assumes a consistent set of units, so you need to be consistent and not mix units
{(i.e., do not mix feet and inches).

Follow the steps described below to create, analyze, and postprocess the model. Input
entities are shown in bold.
Creating the Geometry

Start MSC/NASTRAN for Windows by double-clicking on the MSC/NASTRAN icon.
The Open Model File dialog box appears; choose New Model.

Create the 4 in. Square

Choose Create Line Rectangle. (To do so, choose the Create pull-down menu and
scroll down to Line. This will open another menu, from which you choose Rectangle.)
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Enter the coordinates for the first corner of the rectangle. Enter O (zero) for the X
coordinate, O for the Y coordinate, and O for the Z coordinate; then choose OK. For the
diagonally opposite corner, enter 4 for X, 4 for Y, and O for Z; then choose OK. Adin:
by 4 in. rectangle is now created. '

We could create another rectangle at this point, but will not, so choose Cancel to exit the
rectangle creation dialog box.

The rectangle may be displayed in the corner of the display window. If so, you can resize
and center the display by choosing View Autoscale.
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Display the Curve Labels

The default for the curve and other geometry labels is to be turned off. We will turn them
on here, however, to assist in subsequent operations. To turn them on, choose View
Options, which brings up a dialog box. Select Labels, Entities, and Color.
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Choose Curve from the Options box, which brings up additional small boxes to the right
of the Options box.
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In the Label Mode box, select ID to display curve identifier numbers. Then choose OK to
apply the labels and exit the View Options.
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Fillet the Comers

To fillet the comers choose Modil;y Fillet, which brings up the Fillet Curves dialog box.
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Enter 0.5 for the fillet Radius. To fillet the corner between curves 1 and 2, enter 1 for
Curvel and 2 for Curve2; then, to indicate the fillet direction, enter 3 for X and 1 for Y
to define an approximate fillet center of 3,1; then choose OK.
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Now, change Curvel to 2 and Curve2 to 3, and change X to 3 and Y to 3, to create a
filleted corner between curves 2 and 3; choose OK to apply the fillet.

The filleted comner between curves 3 and 4 can be done in a similar manner, or you could
use the mouse to do so graphically. By using the mouse, point a location just below and
to the left of the approximate center of curve 3; this operation places 3 in the Curvel box.
Next, point to a location just above and to the right of curve 4; this places 4 in the Curve2
box. Note, too, that values for the With Center Near boxes have been filled in. Now,
choose OK to apply the fillet.

Repeat the same procedure by pointing to a location to the right and below the center of
curve 4 (which places 4 in the Curvel box) and then above and to the left of curve 1
(which places 1 in the Curve2 box), and then choose OK. This fillets the remaining
corner.
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Exit the Fillet Curves box by choosing Cancel.
Create the Center Hole

To create the center hole choose Create Circle Center, which brings up a dialog box. -
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Enter 2 for the X coordinate of the center and 2 for the Y corrdinate of the center; then
choose OK, which brings up another box.

Radius

Enter 1 for the Radius and choose OK to create the circle. Then, since we do not want
to create another circle, choose Cancel.
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Save the Geometry

1t is recommended that after nurnerous steps in building a complex model that you save
your model file. While the steps shown above are not numerous--nor is the mode]
complex--it is instructive, nevertheless, to illustrate how to save the model.

To save your model, choose File Save; the Save As dialog box appears (“save as” because
the file has not yet been saved). Enter platel to save the file as platel.mod. Note that
“mod” is the default filename extension for a model file. Note, too, that this filename is
now shown on the MSC/NASTRAN for Windows title bar. Next time you do a save of
this model the updated model file will be saved with the same name.

Creating the Material Properties
Now that we have created the basic geometry we will create the properties, beginning

with the material properties. Choose Create Material, which brings up the Define
Isotropic Material dialog box. (Note that the default material type is isotropic.)
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Material constants can be individually entered or they can be read from a materials library,
which is what we will do in this example. To read the material properties, choose Load,
which brings up the Select Entity box.

E Library Entry

AlSI 4340 Steel

15-5PH Stainless H1025
17-4PH Stainless H1025
2024-T351 Al Plate .25-5
GD61-T651 Al Plate .25-2.

Select AISI 4340 Steél, choose OK, and note that the isotropic material properties are e
entered. Note that the Density is mass density, which is in units of 1b-sec’in.” for English
units. Note, too, that the material ID is 1. R

Choose OK to create the material properties and then Cancel to exit the menu.
Creating the Element Properties
Next we create element properties. Choose Create Property to bring up the Define

Property--PLATE Element Type box. (Note that the default element type is plate
elements.)



 Additional NASTRANM QOptions

Thicknesses, Tavg or 11 Bend Stiffness, 121/T**3
blank or T2 TShear/Mem Thickness,ts/t

blank or T3 Bending {0..Plate Material

blank or T4 Transverse Shear IU.-PIa!e Material

Nonstructural mass/area Memb-Bend Coupling [ﬂ..Nuno - Ignota

| [ Stress Recovery

Top Fiber

Bottom Fibey |D.

Enter 1 in the Material box to assign material 1 to this plate property. (Alternatively, you

could scroll down the available material types by using the down arrow on the side of the
Material box.)

Next, enter the plate properties. Under Property Values enter 0.1 for T1, this is the
thickness of the plates. Defaults for Additional Options are fine for this example.

Choose OK to create the plate properties and then Cancel to exit the menu.

Generating the Mesh

After we define the engineering properties we create the element mesh. First, choose
Generate Mesh Size Default, which brings up a dialog box.

Enter 0.4 for Size (the default mesh size) and then choose OK.

Next, choose Generate Define Boundary to select the boundaries of the mesh. This
brings up the Entity Selection box.
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Select curve 1 (position the cursor near the center of the curve and select it), then in the
same manner select curve 5 (the fillet on the right), curve 2, curve 6, curve 3, curve 7,
curve 4, and finally curve 8--in that order. Then choose OK. The outer edge of the
boundary is defined, and we have to now have to define the inner edge given by the hole.

OK to Create a Hole in Boundary 1 ?

In the OK to Create a Hole in Boundary 1 box, choose Yes, and then select curve 9
(position the cursor over curve label 9 and click the mouse). Then choose OK to define
the hole as curve 9. The box now asks, “OK to Create another Hole in Boundary 1?” and
you choose No, since there is only one hole in this example.

When the Boundary Definition box appears, choose OK to use the defaults, and note that
the boundary edges are then highlighted.
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Next, choose Generate Boundary Mesh and then choose QOK, which brings up the
Generate Boundary Mesh box.
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Enter 1 in the Property box and then choose OK. Automatic quad meshing takes place,
and there may be a 10-45 second wait, depending on the speed of your computer. When
meshing is completed, 135 elements and 107 grid points are generated.
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Modify the Display

In order to better view the model, turn off the element and grid labels. To do so, choose
View Options, and under the Options menu choose Element. Select No Labels under
the Label Mode, then choose Apply. Next choose Node under the Options menu, select
No Labels under the Label Mode, turn off Draw Entity (by clicking on it), and finally
choose OK. Element and grid point labels are now turmed off, as are the grids themselves.



Other entities can also be turned off for clarity. Choose View Options, and under the
Dptions menu select Point, then tum off Draw Entity, and choose Apply. Select Curve,
airn off Draw Entity, then choose Apply. Select Boundary, turn off Draw Entity, then
choose OK. The geometry (curves and points) and boundaries are now turned off.

The filled dot at the origin can also be turned off. Choose View QOptions, then under
Zategory choose Tools and View Style, which brings up another set of boxes. Under.
Options select Origin, turn off Draw Entity, then choose Apply. To tumn off the view
‘egend, select View Legend, turn off Draw Entity, and choose Apply. To turn off the
/iew axes, select View Axes, turn off Draw Entity, and choose OK.
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Zreating the Boundary Conditions

Next, we apply pinned supports to the outer edge. Choose Create Constraint Set.

Enter “Simply supported” in the Title box and choose QK. Choose Create Constraint
Nodal.
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Enter 1 in the ID box and 40 in the to box, then choosé OK; this brings up the Create
Nodal Constraints dialog box.
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Select Pinned to define pinned supports, then choose OK. Pinned supports are applied to
grid points 1 through 40 (the outer edge).
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Choose Cancel to exit the constraint creation.

Creating the Applied Load

Next, we apply a 10g vertical load. Choose Create Load Set. Enter “10g gravity load™
in the Title box and choose OK. Choose Create Load Body to bring up a dialog box.
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select Active to the left of Acceleration and enter -3864 for Z. (This defines a steady-
itate acceleration of 3864 in./sec’--10g--in the -Z direction, which is normal to the plate.)
"hoose OK to apply the acceleration.

saving the Model

save the model again by choosing File Save.

Analyzing the Model

This demo version does not contain the solver, so we will read the MSC/NASTRAN for
windows results that are supplied with this demo.

Processing the Results

Results processing displays the computed results.

Read the Results

Choose File Read Output, select plate1.f06, choose Open, and choose Yes (“OK to

>egin reading file...”).



Modify the Display

Turn off the constraint entities and labels. Choose View Options, select Labels, Entities
and Color, and under the Options box select Constraint. Select No Labels and tumn off
Draw Entity, then choose OK.,

Plot Stre, urs

Choose View Select, which brings up a dialog box.
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Select Contour under Contour Style, and then choose Deformed and Contour Data.
Under Qutput Vectors, Contour pick the scroll bar, scroll down, select Plate Top
VonMises Stress, then choose OK. Choose OK again to draw the von Mises stress

contours.

Cutput Set MSC/NASTRAN Case 1
Contour. Plate Top YonMises Stress




Plot the Deformed Shape

Choose View Select and turn off Contour by selecting None--Model Only under Contour
Options. Then select Deform under Deformed Style. Choose Deformed and Contour
Data, and under Output Vectors, Deformation pick the scroll bar. Scroll down, select T3
Translation (which is Z translatlon), and then choose OK. Choose OK again to draw the
deformed shape.

Note that the deformed shape is plotted in blue and is overlaid on the undeformed (white)
shape. The deformation can better be viewed by rotating the model. Choose View
Rotate, select Isometric, and then choose OK. The model i is rotated such that the
leformation can be seen.

i

WAFNAFRVAY

A

A A

Output Set MSC/NASTRAN Case 1
D eformed(0.000101} T3 Translation

Animate the Deformation

The deformation can be animated. Choose View Select, and under Deformed Style
choose Animate, Choose OK to animate the deformation. The animation continues until
inother menu--any menu--is selected.



Plot Deformation Contours

Choose View Select, select None--Model Only under Deformed Style, and select
Contour under Countour Style. Choose Deformed and Contour Data, and under

Output Vectors, Contour select T3 Translation. Choose OK, and then choose OK
again.
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Exiting the Program

Congratulations! You have successfully completed the first example problem. To exit,
choose File Exit and choose Yes to save the current model,



Working with MSC/NASTRAN for Windows

You can use this demo version to explore the graphics, model building, and results
processing capabilities of MSC/NASTRAN for Windows, by several means:

Display an Example Model

Several sample models are supplied in the \examples directory. These files can be read by
opening an existing model that has a .mod filename extension. For files that have been
saved as neutral files (which are denoted with a .neu filename extension), open a New
Model, choose File Translate, scroll down Format and select FEMAP Neutral File, select
Read, and then Open the file.

Edit an Existing Model

To edit an existing model, choose Open and select the filename when MSC/NASTRAN
for Windows first starts up. Try using different material properties, specifying different
boundary conditions, or applying different loads. Remember to save the model with a
different filename if you do not want to overwrite the original model.

Create a New Model

Using steps similar to those in the step-through example, create new models (of up to 200
grid points). You can “poke around” the menus when creating your models. If you need
help, access the online help by choosing Help Index. You can read or print the help
information in order to learn more about how to use the capabilities.
We recommend creating your model with the following steps:

Create the geometry (Create Point, Create Line, etc.).

Create the material properties (Create Material).

Select the element type (Create Property, then Element/Property Type and select
the element type).

Create the element properties (Create Property).

Generate the element mesh (Generate Mesh Size, Generate On Geometry, etc.).
Create boundary conditions (Create Constraint Set, Create Constraint Nodal, etc.).
Create loads (choose Create Load Set, Create Load Body, etc.}.

Save the model!



Re AD Geome

CAD geometry--in the form of DXF and IGES files--can be imported into
MSC/NASTRAN for Windows. Choose File Translate and under Format scroll down
and select DXF or IGES; then choose Read. The geometry is then read and displayed.

Read a Finite Element Model

Input files from virtually any finite element analysis program can be imported. (Note that
for the demo version these models must be limited to a maximum of 200 grid poinis.) To
read a finite element mode!, choose File Translate and under Format scrolt down and
select the program name; then choose Read. The model is then read and displayed.

Getting Around the Menus

The display is manipulated via the View menu. View New sets up multiple display
windows, each of which can be resized and moved. When you have multiple windows,
display operations take place only for the active window (which is selected by clicking on
it). View Select selects the model display style and postprocessing options. View
Options turns entities on and off individually.

Frequently-used commands have an icon on the Toolbar that runs across the top of the
display window. As you scroll across these icons the description of each is shown at the
top of the screen. For example, the first icon--a circle and an arrow--is dynamic pan,
zoom, and rotate, for which you use the mouse to move (pan), zoom (enlarge), and rotate
the model. :

Many commands can also be selected via color icons in the Toolbox. You can display the
Toolbox by choosing Tools Teolbox. Operations are performed when the appropriate
icon is selected.

Graphics can be saved by choosing File Picture Save, which saves the active window as a
bitmap image. The entire display--all windows and the toolbar--are saved by choosing
File Picture Save Desktop. The bitmaps are saved with a white background for better
black and white hardcopy; this can be changed by selecting File Page Setup and turning
off Swap Black and White.

A useful command is Tools Undo, which undoes the last command. This lets you
experiment with various options and get back to where you started if you make a mistake.



